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 Using the Finite Element Method (FEM)
The Finite Element Method (FEM) Simulator within EMPro provides a complete solution for
electromagnetic simulation of arbitrarily-shaped and passive three-dimensional structures.
It provides a complete 3D EM simulation for designers working with RF circuits, MMICs, PC
boards, modules, and Signal Integrity applications. The FEM simulation provides the best
price/performance, 3D EM simulator on the market, with a full 3D electromagnetic field
solver, and fully automated meshing and convergence capabilities for modeling arbitrary
3D shapes such as bond wires and finite dielectric substrates.

Developed with the designer of high-frequency/high-speed circuits in mind, FEM Simulator
offers a powerful finite-element EM simulator that solves a wide array of applications with
impressive accuracy and speed.

By combining fast solution times, efficient memory usage, and powerful display
capabilities, FEM Simulator delivers leading price/performance solution to complex high-
frequency problems. FEM Simulator users need very little background in electromagnetic
field theory in order to operate and achieve accurate, meaningful solutions.

 Major Features and Benefits
FEM in EMPro provides the following key technological features, which demonstrate the
advantages of full 3D EM design and verification:

Conductors, isotropic dielectrics, isotropic linear magnetic material modeling that
allow a wide range of application coverage.
An unlimited number of ports, which enables simulating multi-I/O design applications
such as packages.
Electric and magnetic fields modeling, enabling visualization of EM fields in a design.
Absorbing boundary condition (free space), enabling antenna modeling.
Full-wave, EM-accuracy for first-pass design success.
Antenna parameters (gain, directivity, polarization, and so on), to enable better
insight into antenna design.
FEM Simulator/ADS integration providing an integrated approach to EM/Circuit
design.

 Application Areas

EM modeling tools are known for their great accuracy. FEM Simulator redefines this term
with broad application coverage, including the following:

Microstrip, stripline, CPW elements (filters, couplers, spiral inductors, via holes, air
bridges, meander lines...)
Multilayer structures
Ceramic filters
Adapters/transitions
Antennas
Couplers
Power splitters/combiners

 Visualization and Display of Results

The visualization and animation capabilities in FEM Simulator enable you to evaluate
simulation results thoroughly. For analyzing designs, you can perform the EM field
animation and dynamic rotation of structures simultaneously. You can choose from shaded
plots or vectors. 3D far-field plots illustrate beam shapes in both azimuth and elevation on
a single plot. To aid in analyzing your designs, EM field animation and dynamic rotation of
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structures can be performed simultaneously. You can choose from shaded plots, contour
lines, or vectors. 3D far-field plots illustrate beam shapes in both azimuth and elevation
on a single plot.

 FEM Simulator Overview
The FEM Simulator commands are available from the EMPro GUI. The following steps
describe a typical process for creating and simulating a design with the FEM Simulator:

Create a physical design: Create a physical design for your FEM simulation in1.
EMPro.
Set Simulation Options: A mesh is a pattern of tetrahedra that is applied to a2.
design in order to break down (discretize) the design into small cells. A mesh is
required in order to simulate the design effectively. You can specify a variety of mesh
parameters to customize the mesh to your design, or use default values and let FEM
generate an optimal mesh automatically.
Simulate the circuit: You set up a simulation by specifying the parameters of a3.
frequency plan, such as the frequency range of the simulation and the sweep type.
When the setup is complete, you run the simulation. The simulation process uses the
mesh pattern, and the electric fields in the design are calculated. S-parameters are
then computed based on the electric fields. If the Adaptive Frequency Sample sweep
type is chosen, a fast, accurate simulation is generated, based on a rational fit
model.
View the results: The data from an FEM simulation is saved as S-parameters or as4.
fields.
FEM Advance Visualization: The FEM Advance Visualization tool enables you to5.
view and analyze, S-parameters, far-fields, and antenna parameters. Data can be
analyzed in a variety of 2D and 3D plot formats. Some types of data are displayed in
tabular form.
Radiation patterns: Once the electric fields on the circuit are known, the6.
electromagnetic fields can be computed. They can be expressed in the spherical
coordinate system attached to your circuit.
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 Understanding the Process of FEM
Simulation
The simulation technique used to calculate the full three-dimensional electromagnetic field
inside a structure is based on the finite element method. This section provides an
overview of the FEM simulation process, its implementation in EMPro, and a description of
how S-parameters are computed from the simulated electric and magnetic fields.

 The Finite Element Method
The finite element method divides the full problem space into many smaller regions
(elements) and represents the field in each element by a local function. The FEM
implementation in EMPro uses tetrahedral elements.

 Representation of a Field Quantity

The value of a vector field quantity (such as the H-field or the E-field) at points inside
each tetrahedron is interpolated from the vertices of the tetrahedron. At each vertex, FEM
Simulator stores the components of the field that are tangential to the three edges of the
tetrahedron. In addition, the component of the vector field at the midpoint of selected
edges that is tangential to a face and normal to the edge can also be stored. The field
inside each tetrahedron is interpolated from these nodal values.

 Field Quantities are Interpolated from Nodal Values

The components of a field that are tangential to the edges of an element are explicitly
stored at the vertices.
The component of a field that is tangential to the face of an element and normal to an
edge is explicitly stored at the midpoint of the selected edges.

The value of a vector field at an interior point is interpolated from the nodal values.
By representing field quantities in this way, Maxwell's equations can be transformed into
matrix equations that are solved using traditional numerical methods.

 Basis Functions

A first-order tangential element basis function interpolates field values from both nodal
values at vertices and on edges. First-order tangential elements have 20 unknowns per
tetrahedra.
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 Size of Mesh Versus Accuracy

There is a trade-off between the size of the mesh, the desired level of accuracy, and the
amount of available computing resources.

On one hand, the accuracy of the solution depends on how small each of the individual
elements (tetrahedra) are. Solutions based on meshes that use a large number of
elements are more accurate than solutions based on coarse meshes using relatively few
elements. To generate a precise description of a field quantity, each tetrahedron must
occupy a region that is small enough for the field to be adequately interpolated from the
nodal values.

On the other hand, generating a field solution for meshes with a large number of elements
requires a significant amount of computing power and memory. Therefore, it is desirable
to use a mesh that is fine enough to obtain an accurate field solution but not so fine that it
overwhelms the available computer memory and processing power.

To produce the optimal mesh, FEM Simulator uses an iterative process in which the mesh
is automatically refined in critical regions. First, it generates a solution based on a coarse
initial mesh. Then, it refines the mesh based on suitable error criteria and generates a
new solution. When selected S-parameters converge to within a desired limit, the iteration
process ends.

 

 Field Solutions

During the iterative solution process, the S-parameters typically stabilize before the full
field solution. Therefore, when you are interested in analyzing the field solution associated
with a structure, it may be desirable to use convergence criteria that is tighter than usual.

In addition, for any given number of adaptive iterations, the magnetic field (H-field) is less
accurate than the solution for the electric field (E-field) because the H-field is computed
from the E-field using the following relationship:

thus making the polynomial interpolation function an order lower than those used for the
electric field.

 

 Implementation Overview
To calculate the S-matrix associated with a structure, the following steps are performed:

The structure is divided into a finite element mesh.1.
The waves on each port of the structure that are supported by a transmission line2.
having the same cross section as the port are computed.
The full electromagnetic field pattern inside the structure is computed, assuming that3.
each of the ports is excited by one of the waves.
The generalized S-matrix is computed from the amount of reflection and transmission4.
that occurs.

The final result is an S-matrix that allows the magnitude of transmitted and reflected
signals to be computed directly from a given set of input signals, reducing the full three-
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dimensional electromagnetic behavior of a structure to a set of high frequency circuit
values.

 

 The Solution Process
There are three variations to the solution process:

Adaptive solution
Non-adaptive discrete frequency sweep
Non-adaptive fast frequency sweep

 

 Adaptive Solution

An adaptive solution is one in which a finite element mesh is created and automatically
refined to increase the accuracy of succeeding adaptive solutions. The adaptive solution is
performed at a single frequency. (Often, this is the first step in generating a non-adaptive
frequency sweep or a fast frequency sweep).

 

 Non-adaptive Discrete Frequency Sweep

To perform this type of solution, an existing mesh is used to generate a solution over a
range of frequencies. You specify the starting and ending frequency, and the interval at
which new solutions are generated. The same mesh is used for each solution, regardless
of the frequency.

 

 Non-adaptive Fast Frequency Sweep

This type of solution is similar to a discrete frequency sweep, except that a single field
solution is performed at a specified center frequency. From this initial solution, the system
employes asymptotic waveform evaluation (AWE) to extrapolate an entire bandwidth of
solution information. While solutions can be computed and viewed at any frequency, the
solution at the center frequency is the most accurate.

 

 The Mesher
A mesh is the basis from which a simulation begins. Initially, the structure's geometry is
divided into a number of relatively coarse tetrahedra, with each tetrahedron having four
triangular faces. The mesher uses the vertices of objects as the initial set of tetrahedra
vertices. Other points are added to serve as the vertices of tetrahedra only as needed to
create a robust mesh. Adding points is referred to as seeding the mesh.

After the initial field solution has been created, if adaptive refinement is enabled, the
mesh is refined further.

 

 2D Mesh Refinement
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For 2D objects or ports, the mesher treats its computation of the excitation field pattern
as a two-dimensional finite element problem. The mesh associated with each port is
simply the 2D mesh of triangles corresponding to the face of tetrahedra that lie on the
port surface.

The mesher performs an iterative refinement of this 2D mesh as follows:

Using the triangular mesh formed by the tetrahedra faces of the initial mesh,1.
solutions for the electric field, E, are calculated.
The 2D solution is verified for accuracy.2.
If the computed error falls within a pre-specified tolerance, the solution is accepted.3.
Otherwise, the 2D mesh on the port face is refined and another iteration is
performed.
Any mesh points that have been added to the face of a port are incorporated into the
full 3D mesh.

 

 Modes
For a waveguide or transmission line with a given cross section, there is a series of basic
field patterns (modes) that satisfy Maxwell's equations at a specific frequency. Any linear
combination of these modes can exist in the waveguide.

 

 Modes, Reflections, and Propagation

It is also possible for a 3D field solution generated by an excitation signal of one specific
mode to contain reflections of higher-order modes which arise due to discontinuities in a
high frequency structure. If these higher-order modes are reflected back to the excitation
port or transmitted onto another port, the S-parameters associated with these modes
should be calculated.

If the higher-order mode decays before reaching any port-either because of attenuation
due to losses or because it is a non-propagating evanescent mode-there is no need to
obtain the S-parameters for that mode. Therefore, one way to avoid the need for
computing the S-parameters for a higher-order mode is to include a length of waveguide
in the geometric model that is long enough for the higher-order mode to decay.

For example, if the mode 2 wave associated with a certain port decays to near zero in 0.5
mm, then the "constant cross section" portion of the geometric model leading up to the
port should be at least 0.5 mm long. Otherwise, for accurate S-parameters, the mode 2 S-
parameters must be included in the S-matrix.

The length of the constant cross section segment to be included in the model depends on
the value of the mode's attenuation constant, α.

 

 Modes and Frequency

The field patterns associated with each mode generally vary with frequency. However, the
propagation constants and impedance always vary with frequency. Therefore, when a
frequency sweep has been requested, a solution is calculated for each frequency point of
interest.

When performing frequency sweeps, be aware that as the frequency increases, the
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likelihood of higher-order modes propagating also increases.

 

 Modes and Multiple Ports on a Face

Visualize a port face on a microstrip that contains two conducting strips side by side as
two separate ports. If the two ports are defined as being separate, they are treated as two
ports are connected to uncoupled transmission structures. It is as if a conductive wall
separates the excitation waves.

However, in actuality, there will be electromagnetic coupling between the two strips. The
accurate way to model this coupling is to analyze the two ports as a single port with
multiple modes.

 

 The 3D Solver
To calculate the full 3D field solution, the following wave equation is solved:

where:

E(x,y,z) is a complex vector representing an oscillating electric field.
μr( x, y ) is the complex relative permeability.

k 0 is the free space phase constant, ,

ω is the angular frequency, 2πf.
εr( x, y ) is the complex relative permittivity.

This is the same equation that the 2D solver solves for in calculating the 2D field pattern
at each port. The difference is that the 3D solver does not assume that the electric field is
a traveling wave propagating in a single direction. It assumes that the vector E is a
function of x, y, and z. The physical electric field, E(x,y,z,t) , is the real part of the product
of the phasor, E(x,y,z) , and εj ω t :

 

 Boundary Conditions

FEM Simulator imposes boundary conditions at all surfaces exposed to the edge of the
meshed problem region. This includes all outer surfaces and all surfaces exposed to voids
and surface discontinuities within the structure.
The following types of boundary conditions are recognized by the 3D solver:

Port
Absorbing (Radiation)
PEC (Perfect Electric Conductor)
PMC (Perfect Magnetic Conductor)
ESymmetry (Electric Symmetry condition - odd symmetry of tangential E-fields)
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MSymmetry (Magnetic Symmetry condition - even symmetry of tangential E-fields)

 

 Port Boundaries

The 2D field solutions generated by the 2D solver for each port serve as boundary
conditions at those ports. The final field solution that is computed for the structure must
match the 2D field pattern at each port.

FEM Simulator solves several problems in parallel. Consider the case of analyzing modes 1
and 2 in a two-port device. To compute how much of a mode 1 excitation at port 1 is
transmitted as a mode 2 wave at port 2, the 3D mesher uses the following as boundary
conditions:

A "mode 1" field pattern at port 1.
A "mode 2" field pattern at port 2.

To compute the full set of S-parameters, solutions involving other boundary conditions
must also be solved. Because the S-matrix is symmetric for reciprocal structures (that is,
S 12 is the same as S 21 ), only half of the S-parameters need to be explicitly computed.

 Absorbing (Radiation)

Radiation boundaries model surfaces that represent open space. Energy is allowed to
radiate from these boundaries instead of being contained within them. At these surfaces,
the second order radiation boundary condition is employed:

where:

E tan is the component of the E-field that is tangential to the surface.

 is the unit vector normal to the radiation surface.

k 0 is the free space phase constant, .

j is equal to .

To ensure accurate results, radiation boundaries should be applied at least one quarter of
a wavelength away from the source of the signal. However, they do not have to be
spherical. The only restriction regarding their shape is that they be convex with regard to
the radiation source.

 

 Computing Radiated Fields

Electromagnetic Design System maps the E-field computed by the 3D solver on the
radiation surfaces to plane registers and then calculates the radiated E-field using the
following equation:

where:
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s represents the radiation surfaces.

j is the imaginary unit, .
ω is the angular frequency, 2πf.
µ0 is the relative permeability of the free space.

H tan is the component of the magnetic field that is tangential to the surface.
H normal is the component of the magnetic field that is normal to the surface.
E tan is the component of the electric field that is tangential to the surface.
G is the free space Green's Function, given by:

where:

k 0 is the free space wave number, .

r and  represent, respectively.

 Implementing Green's Function When Computing Radiated Fields

 

 Displaying Field Solutions

The 3D solver is also used to manipulate field quantities for display. The system enables
you to display or manipulate the field associated with any excitation wave at any port-for
example, the field inside the structure due to a discrete mode 2 excitation wave at port 3.
Waves excited on different modes can also be superimposed, even if they have different
magnitudes and phases-for example, the waves excited on mode 1 at port 1 and mode 2
at port 2. In addition, far-field radiation in structures with radiation boundaries can be
displayed.

The available fields depend on the type of solution that was performed:

For adaptive solutions, the fields associated with the solution frequency are available.
For frequency sweeps, the fields at each solved frequency point are available.
For fast frequency sweeps, the fields associated with the center frequency point are
initially available.

 

 Ports-only Solutions and Impedance Computations
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This section addresses how impedances are computed for multi-conductor transmission
line ports. Some examples of such structures are:

Two coupled microstrip lines
Coplanar waveguide modeled with 3 separate strips
Shielded twin-wire leads

For structures with one or two conductors, you will need to define a single line segment,
called an "impedance line", for each mode. Some examples of such structures include:

microstrip transmission line (two-conductor structure)
grounded CPW (two-conductor structure) where the CPW ground fins are also
attached to the OUTER ground

For these structures, the port solver will compute the voltage V along the impedance line
which is used to calculate Z pv = V 2 /(2*Power). The power is always normalized to 1

Watt.

If one models N-conductor structures where N>2, then FEM Simulator uses a different
algorithm for computing Z pv and Z pi . The user must define an impedance line for each

interior conductor. The impedance lines should go from the center of each interior
conductor to the outer conductor.

The port solver computes a voltage along the first N line segments for each of the first N
modes when the port solver detects that there are N+1 conductors. This becomes a

"voltage vector" 
(of length N) for each of the N quasi-TEM modes. Then, when computing Z pv , the square

of the scalar voltage is now replaced by the dot product of the voltage vectors, for
example:

For a more detailed explanation as to why this is done, refer to reference "1" at the end of
this section.
For Z pi , the current is generally computed by adding the currents flowing into and out of

the port and taking the average of the two. (If the simulator computed currents to perfect
accuracy, the inward and outward currents would be identical.) For all mode numbers >=
N, where N = number of conductors, the currents are calculated in this way.
For the first (N-1) quasi-TEM modes, the currents are computed on the N-1 interior
conductors producing a current eigenvector. Then the impedance:

The result is that the FEM Simulator impedance computations for such structures as
coupled microstrip lines match the published equations for even- and odd-mode
impedances.

As an example, take a CPW modeled as three interior strips surrounded by an enclosure.
The ground strips do not touch the enclosure. Such a model is in the examples directory of
FEM Simulator and is called cpwtaper . The port solver shows us that the desired CPW
mode is not the dominant mode, but is actually mode 3. To identify the modes, one can
use the arrow plots in the Port Calibration menu or the Arrow display of the E-field in the
post processor.
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Each port consists of a 4 conductor system, the outer (ground) conductor, the inner strip,
and the two "ground" strips. This results in 3 quasi-TEM modes. Mode 1 has E-field lines
predominately in the substrate, all pointing in the same direction. This is the common
mode (+V, +V, +V). Mode 2 also has E-field lines predominately in the substrate, but in
opposite directions under the two "ground" strips. This is the slot mode (-V, 0, +V). Mode
3 has nearly zero E-fields everywhere because the fields are predominately between the
inner strip and the "ground" strips. This is the CPW mode (0, +V, 0).

For further help in identifying modes in such a structure, one can look at the distributions
with the "full" scale. One will notice that modes 1 and 3 obviously have the same "even"
symmetry in the E fields, while mode 2 has an odd symmetry. The CPW mode has an
"even" symmetry, so it has to be mode 1 or 3.

Modes 1 and 2 have significant E-field strengths in the substrate, especially under the
"ground" strips. So, there is a potential difference between the "ground" strips and the
outer ground for these two modes. However, for mode 3, the "ground" strips are at the
same potential as the outer ground, which is consistent with the CPW mode.

Thus one can identify the modes. For mode 3, the "ground" strips are at 0 volts with
respect to the outer ground, and the signal line has +V. The Z pv impedance computed for

this mode using a dot product of the voltage vector for mode 3 gives the same Z pv as by

computing the simple voltage between center strip and either "ground" strip. That is

because the voltage vector for mode 3 along the three impedance lines is =[0,V,0] and

However, the impedances for the other modes now match accepted impedance definitions
found in the literature for multi-conductor transmission lines.

G.G. Gentili and M. Salazar-Palma, "The definition and computation of modal1.
characteristic impedance in quasi-TEM coupled transmission lines," IEEE Trans.
Microwave Theory Tech., Feb. 1995, pp. 338-343.
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 Calculating S-Parameters in FEM
Simulation
A generalized S-matrix describes what fraction of power associated with a given field
excitation is transmitted or reflected at each port.

The S-matrix for a three port structure is shown below:

where:

All quantities are complex numbers.
The magnitudes of a and b are normalized to a field carrying one watt of power.
|a i | 

2 represents the excitation power at port i.

|b i | 
2 represents the power of the transmitted or reflected field at port i.

The full field pattern at a port is the sum of the port's excitation field and all
reflected/transmitted fields.
The phase of a i and b i represent the phase of the incident and reflected/transmitted

field at t=0, 
Represents the phase angle of the excitation field on port i at t=0. (By default, it is
zero.)

Represents the phase angle of the reflected or transmitted field with respect to the
excitation field.
S ij is the S-parameter describing how much of the excitation field at port j is

reflected back or transmitted to port i.

For example, S 31 is used to compute the amount of power from the port 1 excitation field

that is transmitted to port 3. The phase of S 31 specifies the phase shift that occurs as the

field travels from port 1 to port 3.

Note
When the 2D solver computes the excitation field for a given port, it has no information indicating which
way is up or down. Therefore, if ports have not been calibrated, it is possible to obtain solutions in which
the S-parameters are out of phase with the expected solution.

 

 Frequency Points

The S-parameters associated with a structure are a function of frequency. Therefore,
separate field solutions and S-matrices are generated for each frequency point of interest.
FEM Simulator supports two types of frequency sweeps:

Discrete frequency sweeps, in which a solution is generated for the structure at each
frequency point you specify.
Fast frequency sweeps, in which asymptotic waveform evaluation is used to
extrapolate solutions for a range of frequencies from a single solution at a center
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frequency.

Fast frequency sweeps are useful for analyzing the behavior of high Q structures. For wide
bands of information, they are much faster than solving the problem at individual
frequencies.

Note
Within a fast frequency solution, there is a bandwidth where the solution results are most accurate. This
range is indicated by an error criterion using a matrix residue that measures the accuracy of the solution.
For complex frequency spectra that have many peaks and valleys, a fast sweep may not be able to
accurately model the entire frequency range. In this case, additional fast sweeps with different expansion
frequencies will automatically be computed and combined into a single frequency response.

 Z- and Y-Matrices

Calculating and displaying the unique impedance matrices (Z) associated with a structure
is performed in the post processor.

 

 Characteristic Impedances

FEM Simulator calculates the characteristic impedance of each port in order to compute a
renormalized S-matrix, Z-matrix, or Y-matrix. The system computes the characteristic
impedance of each port in three ways-as Z pi , Z pv , and Z vi impedances.

You have the option of specifying which impedance is to be used in the renormalization
calculations.

 

 PI Impedance

The Z pi impedance is the impedance calculated from values of power (P) and current (I):

The power and current are computed directly from the simulated fields. The power passing
through a port is equal to the following:

where the surface integral is over the surface of the port.

The current is computed by applying Ampere's Law to a path around the port:

While the net current computed in this way will be near zero, the current of interest is that
flowing into the structure, I- or that flowing out of the structure, I+ . In integrating around
the port, the system keeps a running total of the contributions to each and uses the
average of the two in the computation of impedances.
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 PV Impedance

The Z pv impedance is the impedance calculated from values of power (P) and voltage (V):

where the power and voltage are computed directly from the simulated fields. The power
is computed in the same way as for the Z pi impedance. The voltage is computed as

follows:

The path over which the system integrates is referred to as the impedance line, which is
defined when setting up the ports. To define the impedance line for a port, select the two
points across which the maximum voltage difference occurs. FEM Simulator cannot
determine where the maximum voltage difference will be unless you define an impedance
line.

 

 VI Impedance

The Z vi impedance is given by:

For TEM waves, the Z pi and Z pv impedances form upper and lower boundaries to a port's

actual characteristic impedance. Therefore, the value of Z vi approaches a port's actual

impedance for TEM waves.

 

 Choice of Impedance

When the system is instructed to renormalize the generalized S-matrix or compute a
Y- or Z-matrix, you must specify which value to use in the computations, Z pi , Z pv ,

or Z vi.

For TEM waves, the Z vi impedance converges on the port's actual impedance and

should be used.

When modeling microstrips, it is sometimes more appropriate to use the Z pi

impedance.

For slot-type structures (such as finline or coplanar waveguides), Z pv impedance is

the most appropriate.
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 De-embedding

If a uniform length of transmission line is added to (or removed from) a port, the S-matrix
of the modified structure can be calculated using the following relationship:

Where,  is a diagonal matrix with the following entries:

γ = α + jβ is the complex propagation constant, where:

αi is the attenuation constant of the wave of port i.
βi is the propagation constant associated with the uniform transmission line at port i.
l i is the length of the uniform transmission line that has been added to or removed
from the structure at port i. A positive value indicates that a length of transmission
line has been removed from the structure.

The value of γ for the dominant mode of each port is automatically calculated by the 2D
solver.

 

 Equations
The sections below describe some of the equations that are solved in a simulation or used
to define elements of a structure.

 

 Derivation of Wave Equation

The solution to the following wave equation is found during a simulation:

where:

E( x,y,z ) is a phasor representing an oscillating electric field

k 0 is the free space wave number, .

ω is the angular frequency, 2πf.
µr( x,y,z ) is the complex relative permeability.

εr( x,y,z ) is the complex relative permittivity.

The difference between the 2D and 3D solvers is that the 2D solver assumes that the
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electric field is a traveling wave with this form:

while the 3D solver assumes that the phasor E is a function of x, y, and z:

 

 Maxwell's Equations

The field equation solved during a simulation is derived from Maxwell's Equations, which in
their time-domain form are:

Where:

E (t) is the electric field intensity.

D (t) is the electric flux density, ε E (t), and ε is the complex permittivity.

H (t) is the magnetic field intensity.

B (t) is the magnetic flux density, µ H (t), and µ is the complex permeability.

J (t) is the current density, σ E (t).

ρ is the charge density.

 

 Phasor Notation

Because all time-varying electromagnetic quantities are oscillating at the same frequency,
they can be treated as phasors multiplied by ej ω t (in the 3D solver) or by ej ω t -γ z (in
the 2D solver).
In the general case with the 3D solver, the equations become:
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By factoring out the quantity ej ω t and using the following relationships:

Maxwell's Equations in phasor form reduce to:

where B , H , E , and D are phasors in the frequency domain. Now, using the relationships
B = µ H , D = ε E , and J = α E , Maxwell's Equations in phasor form become:

for σ = 0

Where:

H and E are phasors in the frequency domain, µ is the complex permeability, and ε is
the complex permittivity.

H and E are stored as phasors, can be visualized as a magnitude and phase or as a
complex quantity.

 

 Electric and Magnetic Fields Can Be Represented as Phasors
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 Assumptions

To generate the final field equation, place H in the equation in terms of E to obtain:

Then, substitute this expression for H in the  equation to produce:

 

 Conductivity

Although good conductors can be included in a model, the system does not solve for any
fields inside these materials. Because fields penetrate lossy conductors only to one skin
depth (which is a very small distance in good conductors), the behavior of a field can be
represented with an equivalent impedance boundary.

For perfect conductors, the skin depth is zero and no fields exist inside the conductor.
Perfect conductors are assumed to be surrounded with Perfect E boundaries.

 

 Dielectric Loss Tangent

Dielectric losses can be modeled by assuming that the relative permittivity, , is
complex:

Expressed in terms of the dielectric (electric) loss tangent, , the complex

relative permittivity,  becomes:

 

 Magnetic Loss Tangent

Losses in magnetic materials can be modeled by assuming that µr is complex.

Expressed in terms of the magnetic loss tangent, , the complex relative
permeability becomes:
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 Definition of Freespace Phase Constant

Using the relationships  and , the wave equation being solved can be
placed in this form:

Now, if the freespace phase constant (or wave number) is defined as, , the
above reduces to:

which is the equation that the 2D and 3D engines solve.
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 Using Ports in EMPro FEM Simulation
EMPro FEM supports two kinds of ports: Circuit Component Port and Waveguide Port.

Circuit Component Port and Waveguide Port

 Circuit Component Port
EMPro supports the Component Feed port in the FEM simulation setup.

The Component Feed ports are direct point feeds having a negative and positive
connection point to the metallization of the design.

Component Feed in Circuit Component Port

EMPro FEM only supports New feed definition. The Passive load, Switch, Non Linear
Capacitor and Diode ports are not supported in FEM.
For more information about Component ports at Defining Circuit Components and
Excitations, refer to the Defining Circuit Components and Excitations (using) section.

 Component Feeds

EMPro supports the Component Feed port in the FEM simulation setup. The Component
Feed ports are direct point feeds having a negative and positive connection point to the
metallization of the design.
For more information about Component Feeds, refer to the Defining Circuit Components
and Excitations (using) section.

For FEM simulations, only the following component feed definitions are allowed, which
specify the voltage sources with a termination impedance.

Feed Definition as Voltage
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Feed Definition as Current

The termination resistance can be of any value, but Amplitude can be maximum of 1 V or
1 A. If while defining component port No definition option is used, then after defining
port, appropriate definition of the Voltage source or Current source must be applied.

 Waveguide Port
EMPro FEM also supports Waveguide Port option.

Waveguide Port in Circuit Component Port

Waveguide Port is supported in FEM only. It is not supported in FDTD simulations.
To activate the Waveguide Port, the application should be in FEM mode. After a new
waveguide port option is chosen, the Waveguide Port Editor window opens.
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Waveguide Port supports both Voltage source as well as 1 W modal power feed.

When waveguide port is chosen automatically, both Voltage source and 1 W Modal power
feed is added in circuit component definition.

If there is a voltage source already present, Waveguide port will only add 1 W modal
power source.

To set up a waveguide port with voltage source, refer to Creating a Microstrip Line for FEM
Simulation (fem).

To set up a waveguide port with 1 W modal power source, refer to Performing Multimode
Analysis on Rectangular Waveguide (fem). Modal power feed is useful if modal analysis of
the structure needs to be carried.
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 Specifying FEM Simulation Setup in
EMPro
You can specify the simulation options that are specific to the FEM Simulator in the Create
FEM Simulation dialog box. This dialog box enables you to control how the FEM mesh is
generated and solution is achieved.

In the Simulations workspace window, click New FEM Simulation.

This will open a Create FEM Simulation dialog box where all the set up requirement for
FEM simulation can be entered.

In the Name field, you can enter the FEM simulation name. Name suggested by default
can be used or you can enter the simulation name as per your choice. The invalid symbol
on the window refers that you have not entered any frequency plan.

 Simulation Results to Reuse
EMPro 2010 provides new feature of reusing any existing FEM simulation. For a new FEM
simulation, simulation setup in terms of mesh refinement, AFS points, solver can be
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reused from existing simulation. In Creating FEM Simulation window, the Simulation
Results to Reuse drop-down displays the list of already solved simulations. You can
choose the FEM simulation to be reused using the Simulation Results to Reuse drop-
down list.

To know more about the instances which are useful to reuse, refer to Reuse of Mesh and
Frequency Points (fem) section.

 Specifying Frequency Plans
Using the Create FEM Simulation dialog box, you can specify the frequency settings for
your FEM simulation.

In the Frequencies Plans screen, specify the options as listed in the following table:
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Option Description

Sweep Type Specify the type of sweep: Adaptive, Logarithmic, Linear, and Single.

Start Frequency Specify the start frequency value in GHz.

Stop Frequency Specify the stop frequency value in GHz.

Sample Points Limit Specify the value of sample points limit.

Add To List Adds the specified values to the pane present on the Frequencies Plans screen.

Update Updates the values in the pane present on the Frequencies Plans screen.

Delete Deletes the values specified in the pane present on the Frequencies Plans screen.

Once any frequency plan is added, the invalid symbol on the top of Create FEM simulation
dialog box will turn to valid.

In the Frequencies Plans > Field Storage dialog box, specify the options as listed in
the table following the below screenshot:

Option Description

All frequencies from
the frequency plan
and mesh frequency

Field data will be stored for the frequencies for which either mesh is refined or solution
is calculated.

No field data Field data will not stored for any of the frequencies used in calculation.
This will save space on hard disk. If the intention is just to see S parameter, this
option can be used.

User defined
frequencies

Field data will be stored for only specified frequencies.
The specified frequencies are the frequencies explicitly specified in the frequency plan,
i.e. the start and end frequencies of an Adaptive sweep, any single frequency, all the
frequencies of the linear & logarithmic frequencies. Field solutions will NOT be saved
for frequency automatically determined to sample the Adaptive frequency sweep.

 Specifying the Mesh Refinement Settings
An FEM simulation mesh is a sub-division of the entire 3D problem domain into a set of
tetrahedra (or cells). This pattern of cells is based on the geometry of a circuit and
optionally, user-defined parameters, so each circuit will have a unique mesh calculated for
it. The mesh is then applied to the circuit in order to compute the electric within each cell
and identify any coupling effects in the circuit during simulation. From these calculations,
S-parameters are then calculated for the circuit.
The FEM Simulator implements an adaptive mesh algorithm, where an initial mesh is
generated and the electric fields (and S-parameters) are computed on that initial mesh for
a single frequency. An error estimate is generated for each tetrahedron. The tetrahedra
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with the largest estimated error are refined to create a new mesh on which the electric
fields (and S-parameters) are computed. The S-parameters from consecutive meshes are
compared. If the S-parameters do not change significantly, then electric fields (and S-
parameters) are computed for all the requested frequencies. If the S-parameters do
change significantly, then new error estimates are computed, a new mesh is generated
and new electric fields (and S-parameters) are computed.

Click Mesh/Convergence Properties- (Delta Error: 0.01) in the Create FEM
Simulation window. This displays the Mesh/Convergence Properties- (Delta Error:
0.01) screen, which consists of two tabs: Basic and Advanced.

 Stop Criterium Tab Settings

The following table describes the Stop criterium tab settings:
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Option Description

Delta Error Global Delta S-parameter sets a value that is applied to all S-parameters in the solution.
Enter a value in the Delta Error field. This is the allowable change in the magnitude of the
vector difference for all S-parameters for at least two consecutive refinement passes.

Consecutive
passes of delta
error required

Specify the required consecutive passes of delta error.

Minimum number
of adaptive passes

Enter the number of consecutive passes that must meet or exceed the delta error. If you
have concerns about convergence, you can increase this value, otherwise, use the default
value of 5.

Maximum number
of adaptive passes

Enter the maximum number of passes to be attempted. If the number of refinement
passes entered is reached before the delta error criteria is met, the refinement process
will end, based upon this limit. The number of passes from all prior simulations is also
displayed. Typically, a value between 10 and 20 is recommended.

 Refinement Tab Settings

Using the Refinement tab setttings you can control the frequencies at which the mesh
will be adaptively refined.

The following table describes the Refinement tab settings:

Option Description

Maximum frequency Specifies the highest refinement frequency.

Chosen automatically after initial pass Refinement frequencies are chosen by the solver.

Chosen automatically after each pass Refinement frequencies are not fixed, but can vary from level to level.

Manual Selection Refinement frequencies are generated manually.

For more information, refer to Performing FEM Broadband Refinement (fem).

 Initial mesh Tab Settings

Using the Initial mesh tab settings you can control how the initial mesh is generated.



EMPro 2011.01 - EMPro FEM Simulation

34

The following table describes the Initial mesh tab settings:

Option Description

Use Initial
Target mesh
size

An initial denser mesh can be provided by checking this option. If used, no edge in the initial
mesh will be longer than the given length. If Automatically determine is checked then EMPro
automatically determines the initial target mesh size. The length is computed based on the
frequency plan available when the request is made. To know more, refer to New Features in
EMPro 2010 > Pre-seeding of electrically large structures

Use Initial
minimum
mesh size

This option can be used to set a minimum length of edges in the initial mesh. During mesh
refinement the individual length of edges in the mesh can be shortened where deemed
necessary by the adaptive refinement process. When Automatically determined is selected
an estimate is made of what is a good value for this mesh setting based on the requested
frequencies and geometric size. Using this options restricts the meshing process to a more
limited set of possible solutions. It is advised to only use this options when the initial mesh is
unreasonably dense in some areas due to some combination of geometric features triggering
that behavior.

Conductor
edge mesh
length

Specifies a target mesh size of all edges that belong to the geometry of a conductor. Edges do
not necessarily have to be straight lines.

Conductor
vertex mesh
length

Specifies a target mesh size for all vertices that belong to the geomtetry of a conductor.

For all lengths a parameter or formula is allowed. The formula is always evaluated at the
time the simulation is being created. For further details, refer to the Silver Mesher
documentation.

 Advanced Tab Settings

The following table describes the Advanced tab settings:

Option Description

Target Mesh
Growth

Specifies the percentage by which each adaptive mesh grows relative to the previous
mesh.

 Specifying the Solver Type Settings
Using the Create FEM Simulation dialog box, you can specify the solver type settings and
order of basis functions. Click Matrix Solver- (Direct) to display the Matrix Solver-
(Direct) screen, as shown in the following figure:
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You can select the following solver types to be used by FEM during a simulation.

Direct: When selecting Direct, the FEM Simulator will use a multithreaded sparse
direct solver. The memory requirements and computing time of this solver typically
scale as N^(3/2) to N^2 respectively, where N is the matrix size. This solver does
not suffer from potential convergence problems, and is guaranteed to yield a solution
if sufficient memory is available.

Iterative: When selecting Iterative, FEM Simulator will use the iterative matrix
solver. The memory requirements and computing time of this solver scale as N to
N^(3/2) respectively where N is the the matrix size. In other words, the computing
resources of the iterative solver are typically one order of magnitude lower then the
computing resources of the direct solver. Especially, the iterative solver requires
significantly less memory then the direct solver. However, contrary to the direct
solver, the iterative solver is not guaranteed to converge.
Contrary to the direct solver, the accuracy of the iterative solver can be chosen, by
means of the Tolerance option under Iterative solver > Options. If this option is
decreased, the results will be more accurate. However, the number of iterations will
increase, resulting in an increased solve time. The maximum number of iterations
can be set by the Maximal number of iterations option.

You can specify the Order of basis functions used to approximate the electric fields in
all tetrahedra. The values you can set are

2: Electric fields will be approximated with a quadratic variation in each tetrahedron,
and the magnetic fields will be approximated with a linear variation in each
tetrahedron. This gives the best accuracy.
1: Electric fields will be approximated with a linear variation in each tetrahedron, and
the magnetic fields will be approximated as being constant in each tetrahedron. This
requires less memory than the Order 2 basis functions given the same mesh, but
typically requires a larger mesh to get the same level off accuracy. This setting can
be overall benefitial for electrically small structures.

 Using the Notes Section
If you want to add any notes or observation with your simulation, you can specify it in the
Notes text box. Click Notes in the Create FEM Simulation dialog box to display the Notes
screen, as shown in the following figure:
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After you have completed entering your FEM Simulation options, click the Done button to
apply the current settings in the Create FEM Simulation dialog box, or click Create
Simulation Only to accept the settings. You can also click Create and Queue
Simulation to create and queue the simulation. Alternatively, you can click the Cancel
button to abort the changes and dismiss the dialog box.
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 Viewing FEM Simulation Results
After running the calculation, you can view the results from the Results workspace
window. Some results are displayed in the form of numerical values, while other results
are displayed in the form of plots. There are several types of plots available to view results
based on whether they are time-dependent, frequency-dependent, or angle-dependent:

S-parameter
Sensors
Advanced Visualization

In this section, you will learn about how to display FEM Simulator results.

 Viewing the Default Output of FEM Simulation
To view the default results of a specific project:

Open the Results workspace window by clicking Results in EMPro.1.

Click List Project to open the required project. This opens the EMPro- List Project2.
Results dialog box.
Select the required project and click Choose.3.
In the Results window, you can select the required Output Object, Result Type,4.
and Simulation Number.
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Right-click the required result type in the Results pane, which is present at the5.
bottom.
Select View (default) to display the default output, as shown in the following figure:6.

 Creating a Line Graph
Right-click the required result type in the Results pane, which is present at the1.
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bottom.
Select the Create Line Graph option. This opens the Create Line Graph dialog box:2.

Select the plot type by selecting the required option: XY, Polar, or Smith.3.
Select the required component from the Component drop-down list.4.
Specify Data Transformation option from the drop-down list.5.
From the Complex Part drop-down list select the required option for displaying6.
results: Magnitude, Real, Phase, and Imaginary.
In the Target Graph, select New graph.7.
Click View to view the data.8.

 Viewing S-parameters

 Standard and AFS Datasets

If the Adaptive sweep type is used for a simulation, both the adaptive and discrete S-
parameter results are available in the Results for plotting. The adaptive results contain the
S-parameters from the rational fitting model resamples with a very dense frequency
distribution. The discrete frequency S-parameter results are indicated with 'Discrete
Frequencies' in the Domain column. The adaptive S-parameter results are indicated with
'Frequencies' in the Domain column.

Typically, when viewing data adaptive S-parameter results, you should see very smooth
results, which reflect the behavior of the circuit. Viewing the discrete S-parameter results
on the same plot will show the frequency points for which the simulator was invoked,
superimposed on the smooth curve. Those frequency points will be scattered over the
whole range, with relatively more points grouped in areas where the S-parameters show
more variation. Viewing both datasets can help you determine the quality of the AFS
process on your simulation.

 Viewing S-parameters in graphical format
You can view the S-parameter results retrieved with the port sensor placed at the location
of the Feed. To filter the list accordingly, select the following options in the columns in the
top pane of the Results window (You may need to change your column headings first).

Output Object: Feed
Data Type: Circuit Component
Result Type: S-Parameters

You can view the following formats for displaying S-parameter values for each port:

Magnitude
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Real
Imaginary
Phase

To view S-parameters:

Right-click the result with a Domain value of Frequency to view transient S-1.
parameter results.
Select the Create Line Graph option.2.
Select the data format from the Complex Part drop-down list:3.

Magnitude Displays the magnitude of the S-parameters
Real Displays the S-parameters as complex numbers
Phase Displays the magnitude and phase of the S-parameters
Imaginary Displays the S-parameters as complex numbers

Click View to display the result.4.

 Plotting S-parameter Magnitude
The S-parameter magnitude plot displays magnitude in dB with respect to frequency.

To display an S-parameter magnitude plot:

Select the data you want to view from the S Parameters list.1.
Open the Create Line Graph dialog box.2.
From the Complex Part drop-down list, select Magnitude.3.
Click View.4.

 

 Plotting S-parameter Phase
The S-parameter phase plot displays phase in degrees with respect to frequency. Note
that when viewing S-parameter phase, in some cases the phase delay is plotted. For
example, a layout of an electrical length with a phase of 60 degrees, S21 represents a

phase delay, and appears as -60 degrees. For phases greater than 180 degrees, it may
appear that the phase predicted from Gamma compared to S21 is incorrect, but this is not

so if delay is taken into account.

To display an S-parameter phase plot:
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Select the data you want to view from the S Parameters list.1.
Open the Create Line Graph dialog box.2.
From the Complex Part drop-down list, select Phase.3.
Click View.4.

 Plotting S-parameters on a Smith Chart
The Smith chart displays real and imaginary components of S-parameters.

To display a Smith chart:

Right-click the data you want to view from the S Parameters list.1.
Choose the View Smith Chart option.2.
The Smith chart is displayed:3.
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 Exporting S-parameters
S-parameters can be exported to a Citi file by selecting the S-paramater data in the result
browser, and after right-clicking select Export of CITI file ...

 EMPro FEM-Specific Sensors and Output
From within the results browser, the following sensors can be used for FEM simulations:

• Planar sensors

• Far field sensors

More post processing is possible by using the Advanced Visualization tool available in
the Results window:
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 Using the Advanced Visualization
Feature
The Advanced Visualization feature enables you to view and analyze the following types
of simulation data:

E Fields
Far-fields
Antenna parameters

Data can be analyzed in a variety of 3D plot formats. This section gives an overview on
how to use the Advanced Visualization feature. Viewing FEM Simulation Results describes
in detail how to use FEM Simulator Visualization for viewing specific types of data, such as
S-parameters or currents.

 Starting the Advanced Visualizer
You can invoke the Advanced Visualization feature by clicking the Advanced
Visualization button in the Results window. The current project must run through a
complete simulation use Visualization to view data. If simulation has been previously
completed for a project, you can start the visualizer directly to view the existing data.

 Using the Advanced Visualizer on PC and Linux
Machines
On the PC and Linux platforms, FEM Simulator Visualization is based on the Advanced
Visualizer. The following figure highlights the basic window which comes up when
Advanced Visualizer is invoked.

Upon startup, the following window appears having:
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All the object shading removed.
Two additional tabs for controlling the view are added to the window.

The left side of the Advanced Visualizer contains the basic controls for the view in the
docking widget.

 Types of Plots

The Advanced Visualization supports three basic types of plots:

Shaded Plot - This plot displays the E and H fields on the selected planar surfaces.
Arrow Plot - This plot displays a vector representation of the E and H fields on the
selected planes.
Mesh Plot - This plot displays the FEM Simulator Mesh which is used to compute
the field.

Only one shaded plot and one arrow plot can be displayed. The arrow and shaded plot will
always correspond to the selected excitation. Once an excitation is changed, the plot will
automatically update using the new excitation values at the current phase.

 Solution Configuration Tab

The solution configuration tab is used to select the current excitation for the plots. All of
the plots will automatically reflect the current solution configuration once it has been
selected. By simply selecting either a port or frequency, the excitation is changed and the
plots are automatically updated.

The excitations in the visualization are modal. This means that the solutions are
represented using ports and modes. Excitations are based on these modal solutions.
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Maximum Value
All of the plot properties for a given plot are retained when the excitation is changed with the exception of
the maximum value. This value is reset when the plot is regenerated.

 The Plot Properties Tab

The Plot Properties tab enables you to control the three basic plots, as well as, the
animation settings.

 Plane Entry

FEM Simulator Visualization automatically creates z planes at all the surfaces where there
is horizontal xy plane at a z coordinate. These are displayed in the plane list. Each plane
has a separate button, allowing you to control the individual display on the plane.

Vis - Display the two dimensional triangular mesh which is the intersection of the 3D
mesh with the 2D plane.
Plot - Plots the selected plots within the plane. The plots are determined by the
arrow and shade check boxes.

Besides the default planes, you can enter a new plane using the Add button. The Add
button lets you select three points which define the plane. Once entered, you can plot on
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this plane. A plane can be added by selecting a plan directly also.

Planes can also be moved using the Modify button. When a plane is moved, it is moved
perpendicular to its surface. Anything that is plotted on the place is automatically updated
during this move.

 Shaded Plot

Displaying the shaded current plot is controlled by using the check box next to the plot
name. When it is selected, the plot is visible. Within the plot there are some basic
controls:

Log Scale - This controls whether the scaling and color representation uses a
logarithmic scale or a linear one.
Transparency - This controls the transparency of the shaded plot.

 Arrow Plot

Displaying the arrow plot is controlled by using the check box next to the plot name.
When it is selected, the plot is visible. Within the plot there are some basic controls:

Scale - This controls whether the arrows are scaled, based on the relative magnitude
of the current density through out the design. When it is selected, the arrows will be
scaled, making the lower current density areas have smaller arrows. If it is not
selected all of the arrows will be the same size. However, their size can still be
changed by changing the Arrow Size.
Log Scale - This controls whether the scaling and color representation use a
logarithmic scale or a linear one. If scaling is not enabled, only the color weighting is
affected.
Arrow Size - This controls the relative size of the arrow on the screen. Keep in mind
that if the arrows are not scaled, the default size of the arrow will often appear to be
larger than when the arrows are scaled.

 Mesh Plot

When this plot is enabled the FEM Simulator mesh which is used to compute the field is
displayed. If the surface box is checked, the surface of the 3D mesh is displayed.
Otherwise a 3 dimension wire representation of the mesh is shown.

 Boundary Plot

When this plot is enabled the FEM Simulator boundary surface meshes are displayed.
These meshes are used by the solution process to represent specific boundary conditions,
such as port surfaces and radiation boundaries. By individually selecting the various
boundary types, you can see what surfaces were used for each type of boundary
condition.

Unassigned surfaces can also be seen. These surfaces are those which could be assigned,
but were not assigned during the solution process. If you are not getting the expected
solution, this view is an excellent way to determine if the problem is set up correctly.

 Advanced Options

The advanced options dialogs, selectable from the Shaded and Arrow plot areas enable
you to control the color ranges for the plots and the maximum and minimum values for
the respective plots.

 Shaded Advanced Options
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 Arrow Advanced Options

The arrow advanced options also enables you to change the sampling for the arrow plot
when you change from the default multiplier of 1.
 

Arrow Sampling
When the arrow sampling is changed, it may take a few seconds for the system to update the display.

 Animation

Animation of arrow and shaded plots is controlled by the animation section. There are two
controls within this area.

Display Update - This option determines the minimal time between display updates
in milliseconds. Since some updates may take longer than this setting, it is a
minimum number and not an absolute one.
Phase Increment- This controls the number of degrees added to the current phase
when an update occurs.
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 Far Field Plots

When a problem contains far field data, a second window will be enabled within FEM
Visualization. This window is used to display the far field plots in 3D. By default, the
window is initialized displaying the E field as shown below:

A new docking widget is also added to this widget, which controls the far field options.

These options are:

Plot - Controls the type of plot which will be displayed. Once the plot type is
selected, the window is updated with the plot.
Normalize - This control is used to normalize the data.
Log Scale - This control is used to enable the scaling of the data logarithmically.
Minimum dB - This is the minimum dB value which is used when plotting the data
using the Log Scale.
Polarization Angle - This is the polarization angle in degrees.
Transparency - Controls the transparency of the plot.

The antenna parameters for the far field can be displayed by selecting the Antenna
Parameters button.

 Setting Up the Advanced Visualization on External X Window
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Displays

On Linux Systems, it is common practice to use a local machine as a display and do the
actual processing on another machine. The display from the original machine is typically
mapped back to the local display using the following command:

export DISPLAY=machine:0.0

For using the Advanced Visualizer feature, you need to need to set an additional
environment variable, HOOPS_PICTURE. This environment variable is set to the same
value as the display variable with the addition of X11/ prior to the machine name. Using
the above example, the HOOPS_PICTURE variable would be set to

export HOOPS_PICTURE=X11/machine:0.0

 Validating Your Geometry Visually

You can invoke the Advanced Visualization feature by clicking the Advanced
Visualization button in the Results window. You must select a project name before
launching the Advanced Visualization tool. The following figure highlights the Advanced
Visualization button:

The Advanced Visualizer needs to be started each and every time that you want to review
your design as it does not remain synchronized with the current design. It is
recommended that you do not keep one instance of the visualizer open while an older
instance is present. It will not interfere with the data; however, it might be confusing and
cause an unnecessary error.
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 Identifying and Highlighting Individual Objects

Individual objects can be selected and highlighted in two ways:

Picking on the Screen - Objects can be selected graphically using the mouse. If the
visualizer is in Query mode, an object can be selected by clicking on any line or
vertex of the object. Once selected, the object's lines are highlighted, the object is
selected in the material and object list and the coordinates of the selection point are
displayed in the lower right area of the status bar.

Selection from the Material or Object List - Objects can be selected from either
the material or object list box. Once selected, the object's lines become highlighted.

 

 Identifying and Highlighting Materials

The material selection is located in the docking widget. It has the same controls for
individual objects as the Object Tab. In addition, each material's visibility and shading can
be controlled using check boxes associated with the material itself.

 

 Controlling the Visibility and Translucency of Selected Objects and Materials

Once an object has been selected, its visibility and translucency can be controlled using
the Object Information control located at the bottom of the docking widget. This option
enables you to control the translucency and visibility of an object.

It is also possible to control the visibility and shading for the substrate and mask layers.
Within the Material portion of the docking widget, each material and object has separate
toggles for visibility and shading. By setting these controls appropriately, you can control
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the visibility and shading for all the objects that share this substrate or mask. However,
the translucency can only be controlled at the object level.

 

 Navigating in the 3D Environment

The Advanced Visualizer operates in several different modes. The current mode is
displayed in the lower left portion of the status bar. Regardless of the mode, the mouse
wheel will enable you to zoom in and out of the design at the location of the mouse cursor
on the screen.

Zoom Box - You can select a region on the design by selecting a rectangle around
the area of interest. Once selected, the visualizer will zoom into this area and update
the local rotation origin.
Zoom - You can zoom in or out on the design by moving the mouse up or down on
the image respectively.
Rotate - The rotation mode is the default start up mode for the visualizer. You can
rotate the design around its current origin by holding down the main mouse button
and moving it around the screen.
Pan - You can move the design around on the screen by holding down the main
mouse button and moving it around the screen.
Query - You can query your model using this command. When you click on an
object's edge or vertex, the location and object name are displayed in the status bar.
In addition, the object is highlighted and the object is automatically selected in the
Object and Material tabs in the Docking widget. Visually, a solid dot is placed if the
selected location is on a vertex and a hollow dot is placed if the selected location is
on an edge.

 

 Measuring Distances in the Advanced Visualizer

The measure dialog is activated from the Window/Measure command. Once activated, the
measure dialog is displayed.
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Measurement is done between a reference point and the current query point . The query
point is updated after every mouse selection using the query command. The reference
point remains fixed until it is explicitly updated using the Move Current Point to Reference.
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 Creating Bondwire Geometry
Bondwire allows you to make interconnections between an integrated circuit (IC) and a
printed circuit board (PCB) during semiconductor device fabrication.
It can also be used to connect an IC to other electronics or to connect from one PCB to
another.

 Creating Bondwire Geometry Shapes
In Geometry workspace, chose Extrude from Create drop-down list. The Geometry-1.
Create Extrude window appears.

In the Geometry-Create Extrude window, select Rectangle tool  and draw a2.
rectangular shaped object.

Choose Extrude tab and modify the parameters through Extrude Option (if3.
required).
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Click Done. The rectangular shape is visible in the Geometry window.4.

Similarly, create a circular shape as another geometry shape. The final geometry will
appear as shown below:
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 Creating Bondwire
To create a Bondwire, select Bondwire from Create drop-down list. The Geometry-1.
Create Bondwire window appears.

In Begin: Fixed Position pane, click  icon in Y field and select a start position on2.
the first rectangular object to start the Bondwire connection.

Then, in End: Fixed Position pane, click  icon in Y field and select another3.
position on the second circular object to end the Bondwire connection.
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After selecting the start and end positions, the Bondwire will be created as shown in
the screenshots below.

Click Done to complete the Bondwire creation. The Bondwire is displayed in the4.
Geometry window.
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 Editing Bondwire Definition
To edit the Bondwire definition:

Choose Definitions > Bondwire Definition > Default JEDEC in the project tree.1.
JEDEC is a standard for Bondwire profiles. In EMPro, the Bondwire definitions are
more general and do not have to implement JEDEC profiles. The default Bondwire
definition is a JEDEC profile as an example.

The Bondwire Definition Editor window is displayed.
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The definitions of Default JEDEC Bondwire may appear in Read only mode.
To edit the Bondwire definition, click Edit in the Bondwire Definition Editor window.2.
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The Bondwire Definition Editor consists of three parts: Crossection, profile and preview.

Crossection:

Bondwires have a polygonal cross section. You can choose the radius and the number of
sides.

Preview:

Here you can view a preview of the profile. There are two parameters to steer this, the
preview length which is the horizontal distance between beginning and the end point. The
height difference which is the vertical distance between begin and end point. These values
are not properties of the Bondwire definition. These are just two values necessary for a
preview.

Profile:

Each profile consists of a number of vertices between a beginning and endpoint. The
beginning and endpoints will be choosen when a Bondwire is created so they are not part
of the definition.

The vertices are defined by horizontal and vertical offsets in the vertical plane passing
through beginning and endpoint. Each offset value is accompanied by a type and a
reference:
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Reference: Offsets are added to the horizontal or vertical position of the Previous
vertex, Begin or End point (horizontal offsets are subtracted from the End point
instead). When selecting a vertex in the editor, green markers will highlight the
chosen references.
Type: Each offset is either an absolute Length, Proportional to the horizontal distance
between begin- and end point, or specifies an Angular constraint.
Length: The offset is an absolute length, and will be identical for all bondwires that
use this definition.
Proportional: The offset is proportional to the horizontal distance between begin- and
end point, and the exact offset can differ between different bondwires. Use this for
definitions that need to stretch depending on the location of the bondwire.
Angular: For each vertex, at most one of the offsets can be of the Angular type. It
will put a constraint on the angle between the horizontal line and the line passing
through the vertex and reference point. If both offsets of a single vertex are Angular,
the vertex is invalid.
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 Creating a Microstrip Line for FEM
Simulation
In this project, you will learn how to:

Create a Microstrip Line geometry
Assign a Waveguide port
Setup an FEM simulation

 Getting Started
Open a new project and activate the FEM tab, as shown in the following figure:

In the Project Properties Editor window (from Edit menu), navigate to the Display Units
tab:

Select SI Metric in the Unit Set drop-down list.1.
Change Length to millimeters (mm). This changes the Unit Set value to Custom.2.
Change Frequency Unit to GHz.3.
Click Done.4.

 Creating Materials
Right-click Definitions:Materials branch of the project tree and select New1.
Material Definition.
Double-click the new material to edit its properties. Specify the following properties2.
for the electric conductor material:

Name: Dielectric
Electric: Isotropic
Magnetic: Freespace
Relative Permittivity = 9.9
Conductivity = 0 S/m
Depending on your requirements, you can also set the display color of the PEC
material in the Appearance tab, as shown in the following figure.
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Right-click Definitions:Materials branch of the project tree and select the Default3.
material library. Select the material Cu (copper) and click the Add button. This
material will be added in the list.

 Creating the Microstrip line Geometry
You will create the Microstrip line geometry from 2 simple components: a rectangular
substrate and a Microstrip line. For this example, you will use the Geometry Tools
interface to create a rectangular Extrusion and rectangular Sheet Bodies.

 Modeling the Substrate

First, you will create the rectangular substrate named Substrate. This object will stretch
from (-7.5, -10, 0) to (7.5, 10, 2) and have a 2mm extrusion in the +Z direction.

Right-click the Parts branch of the Project Tree. Choose Create New > Extrude1.
from the context menu.
Name the substrate by typing Substrate in the Name text box in the upper-right2.
corner of the window.
Choose the Rectangle tool from the Shapes toolbar.3.
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The Specify Position dialog box allows exact entry of coordinates. Press the Tab key4.
in the geometry space to activate the Specify Position dialog box. Specify the position
of first point.

Note
If the Specify Position dialog box does not appear, right-click in the geometry space to activate the
window.

Press the Tab key to display the creation dialog for the second point. Enter (7.5 mm,5.
10 mm) and click OK to complete the rectangle.

Navigate to the Extrude tab to extrude the rectangular region. Enter a distance of 26.
mm.
Click Done to finish the Substrate geometry.7.

 Modeling the Microstrip Line
The Microstrip Line will be created with a Sheet Body object that rests on top of the
Substrate. This shape comprises of one rectangle. The line will stretch from (-7.5, -1, 2)
to (7.5, 1, 2).

Right-click the Parts branch of the Project Tree. Choose Create New > Sheet Body1.
from the context menu.
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Navigate to the Specify Orientation tab. Set the origin to (0, 0, 2 mm) to place the2.
Sheet Body on top of the Substrate.

Navigate to the Edit Profile tab. Type Microstrip Line into the Name text box.3.
To draw the Microstrip line, select the Rectangle tool. Use the Specify Position dialog4.
box to enter the corners of the microstrip rectangle:
o Endpoint 1: (-7.5 mm, -1 mm)
o Endpoint 2: (7.5mm, 1 mm)

 Meshing Priority

Ensure that the meshing priority of the Microstrip Line is greater than the Substrate for an
accurate calculation.
Right-click the Microstrip in the Project Tree. Under Meshing Order, select Move to
Top if it is an available option.

 Assigning Materials

Click and drag the CU material object located in the project tree and drop it on top of1.
the Microstrip Line objects in the Parts branch of the tree.
Assign the Alumina material to the Substrate object using the same procedure.2.

The following figure displays the project tree after material objects have been dropped on
their respective parts.
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The following image shows the Microstrip Line geometry with materials applied and colors
set for each.

 Defining the Outer Boundary
Double-click the Simulation Domain> Boundary Conditions branch of the project1.
tree to open the Boundary Conditions Editor.
Set the outer boundary properties as follows:2.

Boundary: Select Absorbing for all boundaries except Lower Boundary Z, which
should be PEC.

Click Done to apply the outer boundary settings.3.
Double-click the Simulation Domain> FEM Padding branch of the project tree. Set4.
the Upper and Lower limits as shown below:
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Click Done.5.

 Adding a Waveguide Feed
You can now add a Waveguide Feed to the Microstrip Line Geometry. It will consist of a
voltage source and series 50Ω resistor connected between Microstrip Line and the ground
plane.

Note
Waveguide Port with Modal power needs to be used for WG or Coaxial structures.

For TEM -type waveguides (e.g. microstrips), you need to use a feed circuit component definition.
For TE/TM-type waveguies (e.g. hollow waveguides), you need to use a modal circuit component
definition.

Define a new circuit component definition from Definition under the project tree , as1.
shown below:

The Circuit Component Definition Editor dialog box is displayed:2.
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Define Waveguide Ports from Project Tree > Circuit Components/Ports as3.
shown below:

From the Waveguide Port Editor dialog box in location tab use  to select4.
edge of Substrate coinciding X=-7.5 mm plane as shown below:

Under Properties tab chose 50 ohm Voltage source in Waveguide Port Definition5.
dialog box as shown below:
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Under Impedance Line define Endpoint1 and Endpoint2 as shown below:6.

Click OK.7.
The impedance line will appear on the waveguide port as shown below:

Waveguide port so defined still show invalid symbol:
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As per the message waveguide port should lie on the faces of the geometry. To
accommodate this we need to change padding in x direction. Both lower and upper
padding in X direction should be 0mm as waveguide port lie on X plane as shown in
figure:

Click Done. This will make waveguide port valid.8.
Similarly define another waveguide port at X=7.5 mm plane. Once both waveguide
port is defined the waveguide ports on the structure look like as shown in following
figure:
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 Setting up new FEM simulation
Click the Simulation tab on right side of GUI. This opens the Simulation window, as1.
shown in following figure.

Click FEM Simulations following window for FEM simulation appears.2.
Add the following Frequency Plans:3.

Under Mesh/Convergence Properties, use following settings in Basic and Advance4.
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tabs:

Under Setup matrix solver, choose Direct solver:5.

Click Create and Queue Simulation on Create FEM Simulation window to start FEM6.
simulation.
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 Simulating a Microstrip Line with
Symmetric Plane
In this project, you will learn how to:

Create a Microstrip Line geometry
Apply Symmetric plane Boundary condition
Assign Port
Set up an FEM simulation

 Getting Started
To demonstrate how to set up symmetric plane, we will use Microstrip 50 Ohm line project
from example set:

Unarchieve the Microstrip 50 Ohm line project from Help > Example.1.
Save the example as Microstrip_50_Ohm_Symm_M.ep.2.

 Modify Microstrip Geometry
To modify the Microstrip Geometry:

Choose and expand Substrate under Parts list.1.

Double-click Extrude to display the part geometry in the Geometry-Editing Extrude2.
window.
In Geometry-Editing Extrude window, choose Tools > Select/Manipulate.3.

Choose Vertex 0 of the substrate for editing.4.
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Right-click on Vertex 0 and select Edit Position.5.

Under Position pane, change V coordinate to 0 and uncheck the Lock check box. This6.
will reduce the width of the Substrate to half.
Click Ok.7.
Then, click Done on the Geometry–Editing Extrude window.8.

Similarly, to reduce the Strip width to half:

Choose and expand Strip under Parts list.1.

Double-click Strip to display the part geometry in the Geometry-Editing Sheet Body2.
window.
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In Geometry-Editing Sheet Body window, choose Tools > Select/Manipulate.3.

Choose Vertex 2 of the Strip for editing.4.

Right-click on Vertex 2 and select Edit Position.5.

Under Position pane, change V coordinate to 0 and uncheck the Lock check box. This6.
will reduce the width of the Strip to half.
Click Ok.7.
Then, click Done on the Geometry–Editing Sheet Body window.8.

Final geometry is displayed as shown below:
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The above figure displays that the Ports are at edges of the Substrate.

 Applying Symmetry Boundary Condition
To apply the symmetry boundary condition:

Switch off the FDTD simulation option. The Symmetry boundary condition is1.
applicable only for FEM simulator.

Choose Simulation Domain > Boundary Conditions from the project tree. The2.
Boundary Condition Editor is displayed.

Change Y parameter of Lower Boundary to MSymmetry and click Done.3.
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Now, choose Simulation Domain > FEM Padding from the project tree. The FEM4.
Padding Editor is displayed.

Change Y parameter of Lower from 0 mm from 20 mm and click Done.5.
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 Setting up New FEM Simulation
To set up a new FEM simulation:

Click the Simulation tab  on right-side of the EMPro GUI. The Simulation1.
window is displayed.

Click Create FEM Simulation. The EMPro-Create FEM Simulation window for FEM2.
simulation appears.
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Add the Frequency Plans as shown in the EMPro-Create FEM Simulation window3.
below.

Under Mesh/Convergence Properties pane, perform the settings as displayed in the4.
below screenshots:

 Basic Properties
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 Advanced Properties

Choose Direct solver in Matrix Solver window.5.

Click Create and Queue Simulation to start the FEM simulation.6.

 Visualizing Symmetric Plane
To visualize the symmetric plane:

Click the Results tab  on right-side of the EMPro GUI. The Results window1.
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is displayed.

In Results window, select the project and click Advance Visualization tab.2.
After you click the Advance Visualization tab, the EMPro Project window is displayed.3.
In the EMPro Project window, select a project Status and click OK.4.

In the Advance Visualization, click Plot Properties tab.5.

Under Mesh/Boundaries pane, select the Boundaries Visible check box.6.
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Boundaries are visible on the object now. The pink color represents the symmetric
plane.

To view the internal structure of the object, uncheck the Symmetric check box in
the Mesh/Boundaries pane.
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 Simulating a Microstrip Line with Sheet
Port
In this project, you will learn how to:

Define a sheet current source

 Getting Started
To demonstrate how to set up a sheet current source, we will use the Microstrip 50 Ohm
line project from the example set:

Unarchieve the Microstrip 50 Ohm project from Help > Example.1.
Save as Microstrip_50_Ohm_Sheet.ep.2.

 Adding Sheet to Port
Double-click Port 1 under Circuit Components/Ports in the project tree. The1.
Geometry-Editing Circuit Component windows appears.

Click Extent tab. The sheet parameters are displayed.2.

For Endpoint 2, Click  to specify the position and select one corner of Microstrip3.
line as shown below:
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Endpoint 2 will display the coordinates of one corner of the Microstrip line.

Copy X and Y coordinates from Endpoint 2 and paste to Endpoint 1.4.

Select Use Sheet check box and click Done.5.

A sheet will appear of width equal to the width of the Microstrip line starting from the base
of the substrate to the Microstrip line.
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Following the above demonstrated process, add a sheet to Port 2 also.

 Setting up New FEM Simulation
Click the Simulation tab on right-side of EMPro GUI. The Simulation window1.
appears.

Click Create FEM Simulation on the Simulation window. The EMPro-Create FEM2.
Simulation window appears.
Add the Frequency Plans as shown below.3.
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Click Field Storage tab and select User Specified frequencies radio button. This4.
will save field data only at the starting and end frequency of the Adaptive frequency
sweep.

Click Setup Mesh/Convergence Properties tab and perform the Basic and5.
Advance settings as shown below.
Basic Settings

Advance Settings
In Advanced tab, choose Use Initial Target Mesh Size check box.

Click Matrix Solver tab and select Iterative radio button.6.
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Click Create and Queue Simulation on EMPro-Create FEM Simulation window to7.
start FEM simulation.

 Result Comparison
An important advantage of sheet current sources is that they have a smaller parasitic
inductance than line current sources.

This is highlighted in the following plot, showing S11 with and without sheet ports. If
sheet ports are used, the resonance frequencies are shifted to the left. This shift is caused
by the reduction of the parasitic inductance of the current sources.
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 Performing Multimode Analysis on
Rectangular Waveguide
In this section, you will learn how to create a multimode analysis on any structure in
EMPro. To demonstrate the design flow we have used a square waveguide. Perform the
following steps to analyze a rectangular waveguide:

Set up Waveguide Geometry Model
Set up Waveguide Ports
Set up Simulation
View Results

 Setting up Waveguide Geometry Model
You can set up a waveguide geometry model by performing the following steps:

Select Create > Extrude to draw a square waveguide.1.
Choose Rectangle and specify the inner dimensions as ( -20 mm, -20 mm) and (202.
mm,20 mm). Also, specify the outer dimensions as (-21mm, -21 mm) and (21
mm,21mm).
Extrude the waveguide to 50 mm length. This will draw a square waveguide of 403.
mm x 40 mm cross section and length 50 mm.

Note
This waveguide will support TE10 and TE01 mode at C band.

Specify the name the of the waveguide as Square Waveguide and assign the4.
material Aluminium. The resulting waveguide appears as follows:
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 Setting up Waveguide Ports
You can set up a waveguide port by performing the following steps:

Right-click Circuit Components/Ports> and select New Waveguide Port to a new1.
waveguide port. This opens the EMPro Waveguide Port Editor, as shown in the
following figure:

Choose view Bottom( _z)to define the Waveguide port at Z equals to 0mm value.2.

From Waveguide Port Editor > Location, choose  to select the face:
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Under the Edit cross section, remove the selection of Auto Extend to simulation3.
domain boundaries. This will restrict waveguide port to waveguide cross section
only.
Under Properties, choose Waveguide Port Definition and choose the number of4.
modes equals to 2. Also, for Waveguide port definition choose 1 W Modal power feed,
as shown in the following figure:

Under Impedance for Endpoint 1, choose center of the lower edge.5.
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For endpoint 2, choose center point of the upper edge.6.

This defines mode 1 for port 1. Similarly define mode 2 for port 1.



EMPro 2011.01 - EMPro FEM Simulation

91

If Waveguide port 1 still show invalid please change the padding as shown below:

While doing the FEM padding of waveguide structure, consider the following guidelines:

The +/- Z padding MUST be zero for a valid waveguide port definition. The padding in
the orthogonal direction of waveguide plane should be 0 mm. In this case, the Z axis
is orthogonal to waveguide planes. After placing these paddings, the waveguide port
will become valid.
The +/- X and Y padding COULD be set to zero for a more efficient simulation Choose
Top(-z) view to define second waveguide port at z=50 mm. Repeat the same steps
as defined above to create second waveguide port and two modes.

A Waveguide with waveguide ports having two excited modes appears as follows:
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 Setting up Simulation
Select simulation and New FEM simulation. Define the frequency plan as shown1.
below:

Choose following Mesh/Convergence properties.2.
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Choose direct solver and press Create and Queue simulation.3.

 Viewing Results

 Viewing S Parameter

For waveguide port 1, port 1 and port 2 are defined for 2 modes. And for waveguide port
2, port3 and port4 are defined for 2 modes. So port 1 of waveguide port 1 will couple to
port 3 of waveguide port2 since they are for same mode. Similar coupling will take place
for port 2 and port 4. The S13 and S24 plot is:

Cross mode coupling S14 and S23 is shown below:
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The set of equations solved by FEM become ill-conditioned at waveguide mode cut-off
frequencies. This leads to the spike in S14 and S23 seen around 3.75 GHz

 Viewing Propagation Constant

TE10 and TE01 mode is degenerate mode in square waveguide. For degenerate mode’s
the propagation constant is same as shown in plot below:

 Viewing Field

Viewing field for different modes. From Result window> Choose project and then Advance
Visualization. In advance visualization choose solution setup and select one of the
frequency in pass band. For following plots frequency of 6.9 GHz is selected. Also choose
Port 1 mode 1 to see TE10 mode in the waveguide.
In Plot properties, choose Z=0 in field plot planes. Choose Shaded plot and log scale. The
plot will appear as
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Select animate to see the progress of the field with phase. Remove the selection from
Shaded plot and select Arrow plot. This is TE01 mode, as shown below:

Go to Solution setup and select Port 1 mode2. Choose shaded plot in solution setup.

Uncheck shaded plot and check arrow plot. This is TE01 mode:

Add a plane by choosing Add in field plot planes to see the field along the length of the
waveguide section.
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Move this plane on the centre of the waveguide by using edit option. Choose Shade plot to
see fields on this plane.

Similarly arrow plot on the plane is shown below:
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 Troubleshooting Mesh Failures
If the mesh generation fails in the surface meshing a list of failed faces assembled in an
SAT file will be generated in the design directory. The exact location of this file will be
shown in the output window of the simulation.

 Best practices
Simplify the design by removing unnecessary (for the EM-modeling) detail. Various
geometry modification tools are available within the EMPro GUI to achieve this.
Avoid shelled objects where the thickness of the shell is much smaller than the total
dimensions of the object. In this case, replace the thick shell with a thin sheet.
Visually inspect the design for small gaps between two 3D objects. Consider
removing the gaps by moving one of the objects to create overlap between objects.
Avoid using complex Boolean subtractions: use the mesh priority to set the correct
object precedence for meshing. For example, a metal object sticking through a
dielectric object will be meshed as such if the priority of the metal object is set to a
higher value than the dielectric object.

To isolate specific objects that are causing mesh failures, you can selectively include or
exclude objects from a simulation by using the Include In Mesh option in the context
menu of objects.

 Known Issue

 Using English units may create small gaps or slivers in some
designs, which can lead to mesh failures

EMPro uses SI (metric) units as the default system units. When a design is created and
modified using English units, an internal unit conversion is made during each operation.
Each internal conversion introduces small rounding errors. As more operations are
completed, the rounding errors can accumulate to the point where small gaps or slivers
may appear in the design. The FEM mesher has difficulty in meshing geometries
containing these small gaps or slivers. This problem can be minimized either by finding
and eliminating the small gaps or slivers, by reducing the number of operations on a
design (reducing the number of internal unit conversions), by using metric units during
the creation and modification of the design (eliminating internal unit conversions), or by
using “Match Points” alignment tool. This issue will be addressed in the next release of
EMPro.

 Tips for avoiding this problem

Import designs using metric units. This will reduce the occurrence of errors caused by
the conversion between metric units and English units.
When designs are imported in English units, move designs as a group, and minimize
unnecessary drawing operations to avoid the creation of small gaps or slivers.
When performing operations, such as moving, on designs containing imported
objects, using the “Match Points” alignment tool may eliminate any small geometrical
offsets created.
Create parametric equations in metric units. The conversion between metric and
English units has limited precision, so mixing parametric equations and direct
coordinate entry may introduce small gaps or slivers.
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 Symmetry Plane Boundary Condition
The Symmetry Plane Boundary Condition is supported by FEM simulator option only. It can
be applied to structures which have electric (E) and magnetic fields (M) symmetry. This
can be understood by simple structure like microstrip line and rectangular waveguide
operating in dominant mode.

 Microstrip line

 Rectangular Waveguide

If a structure has any symmetry (E or M), the structure physical size can be made half
and symmetric plane boundary condition can be applied. Symmetric plane will take care of
other half. This way the size of the problem subjected to simulation is reduced to half
which now can be simulated in less amount of memory and lesser time. If a structure has
both kind of symmetry (like rectangular waveguide)then it can be reduced to quarter, thus
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giving further advantage on memory and time.

Symmetric plane can be accessed under Simulation Domain > Boundary Conditions in
the Project Tree.

Following are few guidelines to follow when specifying circuit sources with symmetry
planes:

Circuit sources should be parallel to MSymmetry planes.
Circuit sources should be normal to ESymmetry planes.
If there are symmetry planes, then circuit sources should ‘touch’ all symmetry
planes.

Note
For more details on how to create a symmetric plane and apply the symmetric plane boundary condition,
see Simulating a Microstrip Line with Symmetric Plane (fem) .
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 Internal Sheet Ports with Reduced
Parasitics
The primary non-compensated (or parasitic) effect of the internal ports implemented in
EMPro FEM is a self-inductance generated by the current impressed locally by the source.

In EMPro 2009, this locally impressed current has a distribution that is localized to the
impedance line which is the path along which the voltage of the source is computed
(displayed in the 3D EM Preview window). The parasitic inductance of this source is
approximately the inductance of a wire that has the length of the impedance line and a
small effective radius. The effective radius is impacted by both the local mesh density and
mesh orientation.

In EMPro 2010, the impressed current of a current source can be distributed uniformly
along a user-defined sheet. As such, the parasitic inductance of this source is essentially
the inductance of a sheet of uniformly distributed current with an effective thickness. This
thickness is of the same order as the effective radius of the non-distributed source
implementation.

Sheet current sources have the following advantages in comparison to non-distributed
current sources:

Lower parasitic inductance
Decrease in the current fan-out as the current spreads to be the current distribution
of the signal line

Note
For details on how to implement sheet ports with reduced parasitics, see Simulating a Microstrip Line with
Sheet Port (fem) .
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 Debye and Lorentz Materials
EMPro 2010 adds support for Debye and Lorentz material properties. This allows modelling
of frequency dependent materials including FR4 and plasmas.

To define a new material, right-click Definitions: Materials branch of the Project Tree
and select New Material Definition. A Material object will be added to this branch.
Depending on the project preferences, the Material Editor window will appear
automatically. If not, simply double-click on this object to bring up the editor. Similarly,
double-click on any existing Material icon to edit an existing material within the Material
Editor.

 Debye/Drude  

For a Debye/Drude material, the electrical Conductivity ( ) in siemens per meter, Infinite

Frequency Relative Permittivity ( ), Number Of Poles, Static Relative Permittivity ( ),
and Relaxation Time ( ) in seconds must be specified. For a Debye material,  must
equal zero. A non-zero conductivity value results in a Drude material.

 Defining a Debye/Drude material

 Lorentz

For a Lorentz material, the electrical Conductivity ( ) in siemens per meter, Infinite

Frequency Relative Permittivity ( ), Static Relative Permittivity ( ), Resonant
Frequency and Damping Coefficient must be specified.

 Defining a Lorentz material
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Note
For more details on how to specify Debye and Lorentz materials, see Creating Materials (using) .
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 Reuse of Mesh and Frequency Points
EMPro 2010 provides a new feature for reusing any existing FEM simulation.

For a new FEM simulation, simulation setup in terms of mesh refinement, AFS points,
solver can be reused from existing simulation. The results from an existing FEM simulation
can be reused in a new FEM simulation. In this case, the results from the existing
simulation will be the starting point for the new simulation.

To demonstrate how to reuse the simulation setup, we will use the QFN Package project
from the example set:

Unarchieve the QFN Package project from Help > Example.1.
Open the QFN Package.ep.2.
Click the Simulation tab on right-side of EMPro GUI. The Simulation window appears.3.
Click Create FEM Simulation on the Simulation window. The EMPro-Create FEM4.
Simulation window appears.
Add the Frequency Plans relevant for your project.5.
Once the simulation seetings are complete, click Create and Queue Simulation on6.
EMPro-Create FEM Simulation window to start FEM simulation.

You can reuse the above created simulation in another simulation by selecting a
simulation from list of already solved simulations from the Simulation Results to Reuse
drop-down list in the EMPro-Create FEM Simulation window. Change the pre-existing
simulation settings according to your new requirements, and start the new simulation. In
the output, it will be shown which results are reused.

Following are few scenarios where reuse of already solved simulations option can be
useful:

Increasing the maximum number of refinement steps - This can be useful if the1.
mesh refinement did not converge.
Increasing the accuracy - This can be done by decreasing target delta S or by2.
increasing the number of consecutive passes the target delta S criterium must be
satisfied. This will result in additional refinement steps.
Changing the refinement frequency - Additional refinement steps will be done for3.
the new refinement frequency. This can be useful if the field solutions are
fundamentally different for different frequencies. It also can be used to achieve a
broadband refinement.
Increasing the maximum number of frequency points for AFS - This is useful if4.
AFS did not converge.
Using a different setting for the linear solver:5.

If the direct solver aborted because of an out of memory problem, the1.
simulation can be continued by reusing it with the iterative solver selected
instead.
If the iterative solver aborted because it did not converge, the simulation can be2.
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continued by reusing it and:
either allowing more iterations for the iterative solver or,1.
decreasing the tolerance for the iterative solver or,2.
with the direct solver selected instead.3.

Changing the frequency plan:6.
Extending the frequency range.1.
Adding discrete frequencies: this can be used to force AFS to zoom in into a2.
specific frequency range.

Any of the above use scenario’s can be combined.
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 Broadband Refinement in FEM
In EMPro 2011.01, the broadband refinement process is automated. You can select one of
the following refinement strategies depending on your requirements:

Multiple fixed refinement frequencies
Refinement frequencies chosen automatically after the initial pass
Refinement frequencies chosen automatically after each pass
Manual refinement frequency

This section describes these refinement frequencies and provides guidelines for choosing a
strategy.

 Importance of Refinement Frequencies
Mesh refinement procedures in FEM typically consist of the following steps:

Simulate at the refinement frequencies.1.
If the calculated S-parameters did not reach convergence:2.

Estimate the discretization errors of the field solution.1.
Refine the mesh at locations with high values for the error.2.
Repeat step 1.3.

In this procedure, the refinement frequencies play a key role:

Convergence monitoring: the convergence of the refinement process is monitored
at the refinement frequencies (step 2).
Field error estimation: the field error estimates, upon which the mesh refinement
will be based, are calculated at the refinement frequencies (step 2a).

Consequently, the choice of the refinement frequencies can have an important impact on
the accuracy of the simulation results:

The mesh convergence should be monitored at frequencies where the S-parameters
change most during mesh refinement. If this is not the case, the refinement process
might stop too early, i.e., before the mesh refinement has reached convergence over
the entire frequency range of interest.
All important electromagnetic phenomena should occur at one of the refinement
frequencies. If this is not the case, these phenomena cannot be taken into account
during mesh refinement.  As a consequence, it is possible that the final mesh is not
suited to represent these phenomena accurately.

 Performing Manual Broadband Refinement
Previously, FEM mesh refinement considered only one single frequency, which remained
fixed during the entire refinement process. Refinement at multiple frequencies could be
achieved only manually by reusing previous simulation results. For instance, refining at
two frequencies f1 and f2 is achieved as follows:

Simulate with the refinement and solve frequency set to F1.1.
Resimulate by using the previous simulations results with the refinement frequency2.
set to f2. Also, set the solve frequency plan to the required frequency range.

 Performing Automatic Broadband Refinement
In EMPro 2011.01, broadband refinement is automated. You can choose a refinement
strategies in the Refinement tab in the FEM Simulation Options dialog box:
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 Multiple Fixed Refinement Frequencies

The user can specify a set of refinement frequencies by selecting the button ‘Manual
selection’, and adding frequencies to the frequency table. This refinement strategy
behaves as follows:

All refinement frequencies will be simulated on each mesh level
Convergence is reached if the convergence criterium is satisfied for all refinement
frequencies. In other words, convergence depends on the worst case refinement
frequency on each level.
The mesh refinement will depend on the error estimates of all refinement
frequencies.

The corresponding logfile shows:

Delta(S) for each simulated frequency
Worst case Delta(S) for each mesh level (last line)
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 Refinement Frequencies chosen Automatically After Initial Pass

In this refinement strategy, the refinement frequencies are not user-defined, but chosen
by the solver. For this purpose, the entire target frequency plan is simulated on the initial
mesh. Based on an analysis of the resulting S-parameters, a set of refinement frequencies
is chosen. Typically, these frequencies will be the frequencies for which the diagonal
elements of the S-parameter matrix reach a minimum. The selected refinement
frequencies will be used in all subsequent refinement passes.

Except for the AFS sweep on the initial mesh level, this refinement strategy is identical to
the strategy based on user-defined refinement frequencies.
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 Refinement Frequencies Chosen Automatically After Each Pass

In this refinement strategy, the refinement frequencies are not fixed, but can vary from
level to level. This refinement strategy behaves as follows:

The entire target frequency plan will be simulated on each mesh level using an
adaptive frequency sweep.
The difference of the S-parameters of the rational models will be monitored, instead
of the difference between the S-parameters of the simulated frequencies only. In
other words, convergence depends on the worst case frequency in the entire
frequency range of interest. This is the most detailed convergence monitoring
possible.
The mesh refinement will depend on the error estimates of all simulated frequencies.

 Selecting a Refinement Strategy
You can refer the following guidelines while selecting a refinement strategy:

Multiple fixed refinement frequencies: This strategy computes the fewest
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frequency points during the adaptive refinement stage and therefore will usually lead
to the fastest simulations. This strategy is recommended for:

Electrically short transition structures. These can include matching networks,
packages, impedance transformations, etc. If the transmission parameters
accumulate less than 180 degrees of phase, then it is sufficient to refine only at
the highest frequency.
Designs where you know the frequencies of the critical features. These can
include dual (or multi-) band antennas, band pass filters etc. For these
structures set the refinement frequencies to the frequencies of most interest
(i.e. in each antenna frequency band, at the low end and high end of the band
pass filter). In many cases it is advisable to also include the maximum
frequency of the simulation as a refinement frequency.
Initial analysis of a structure where speed is preferred over accuracy.

Refinement frequencies chosen automatically after the initial pass: This
strategy is a compromise between manually selecting the refinement frequencies and
letting the FEM simulator automatically select the refinement frequencies at each
adaptive pass. This strategy is recommended when you do not have a good idea a
priori where the important characteristics will occur in your frequency but you know
the frequency transitions are not extremely sharp (i.e. are not high Q resonances).
Refinement frequencies chosen automatically after each pass: This is the
automated strategy and tends to generate accurate results, but it also tends to result
in the longest simulation times. This strategy is recommended:

For structures with high Q resonances.
During final analysis of a structure where accuracy is preferred over fast
simulations.
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 Using Advanced FEM Mesh Controls
EMPro 2011.01 provides new advanced FEM mesh control settings that improve the
accuracy of the simulation results and ensure an efficient adaptive meshing. EMPro
2011.01 includes the following additional mesh controls in FEM:

Vertex mesh length
Edge mesh length
Surface mesh length

These advanced FEM mesh control settings provide the following benefits:

Ensuring an efficient adaptive meshing behavior: the additional mesh controls builds
a finer initial mesh so the adaptive meshing does not need to go through a large
number of steps to arrive at the same level of mesh elements. Areas mainly around
conductors are susceptible for under meshing during initial meshing. With the finer
mesh controls some of this knowledge can be injected by applying additional mesh
settings to conductors but also at the individual object level.

Improving the precision of the simulation results: the quality of the final mesh after
adaptive meshing is higher. With the additional mesh settings known at the initial
meshing stage this step can take all the requested constraints into account while
during adaptive meshing quality properties of the mesh are balanced against mesh
performance and electromagnetic constraints. The edge and vertex meshing in
particular allow to better model singular effects at material interfaces.

 Using the Microstrip Design Example
To define the advance FEM mesh controls, a microstrip design example is used in this
document. The strip is 2 mm wide and 15 mm in length, as shown in the following figure:

In the above figure, each block represents the following advanced controls:

Mesh 1: No additional settings applied.
Mesh 2: Edge mesh settings applied to the strip.
Mesh 3: Vertex mesh settings applied to the strip.
Mesh 4: Surface mesh settings applied to the strip.
Mesh 5: Edge and surface mesh settings applied to the mesh.

The length of the mesh edges is dictated by the geometry and limited by the overall
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target mesh length setting.

 Defining the Advanced FEM Mesh Controls

 Edge Meshing

Edge meshing reduces the mesh length around the edges. In the micro-strip design
example, edge mesh length is specified as 0.1 mm and corresponds to Mesh 2. The mesh
is generated by applying an edge mesh to the strip line running on the substrate. Around
the edges of the strip, the length of mesh edge is reduced to 0.1 mm. A fan-out effect is
created to maintain the tetrahedron quality. The edges do not need to be straight lines,
any shape is allowed. The mesh below is used only for illustrative purpose. While
performing meshing, the density of the edge mesh does not need to be as high as
pictured. A good value is one fifth of the width of a strip. On the other hand, for the above
configuration, Momentum uses one third of the width as estimated when edge meshing is
configured by using default values.

 Vertex Meshing

Vertex meshing reduces the mesh length around vertices. In the micro-strip design
example, the vertex mesh length is set to 0.033 mm and corresponds to Mesh 3. Again a
fan-out effect is observed which is necessary to maintain mesh quality. When combined
with edge meshing the shortest length of both is chosen in any given region. The region
where the value is applied by the vertex mesh length setting is roughly twice its length in
each direction: the actual region is still being optimized. The region affected by it depends
on local geometry.

Note
Vertices in EMPro are zero-dimensional entities, like edges are one-dimensional. You can recognize
vertices in straight line designs as the corners of shapes. During sketching vertices will advertise
themselves as vertex0, vertex1,when hovering over them.
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 Surface Meshing

Surface meshing reduces the mesh length on surfaces of objects. In the micro-strip design
example, the surface mesh length was set to 0.5 mm and corresponds to Mesh 4. Note
that the given length only serves as a guidance for the surface meshing process. The
mesh length is not exactly 0.5 mm everywhere on the strip. This effect is caused by the
fact that the edge mesh length was not explicitly set. In that case, internally, the edge
mesh length is reduced to five times the surface mesh length. This is necessary to
maintain mesh quality and keep the performance of the meshing process under control.
This options is useful when the affected region of the mesh control settings needs to be
limited. The surface mesh length is not affecting other objects nearby the strip.
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 Combined Edge and Surface Meshing

In the micro-strip design example, the edge and surface mesh length have both been set
to 0.5 mm. This corresponds to Mesh 5 in the micro-strip design example. The main
difference with the surface meshing applied in isolation is that the fan out of the meshing
reaches into the substrate.

 General settings and GUI

Edge and vertex mesh length can be set globally and are part of the simulation settings.
In this case, they only apply to conductors. Objects settings take higher priority but only
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when they dictate a smaller mesh length. It is not possible to override an edge length per
object with a length larger than the globally applied setting. A value of 0 means that the
setting is ignored. Negative values will result in an invalid simulation setup. The values
may be parameters if desirable. The per object settings are reachable through the context
menu and are part of the “Meshing Properties” of an object.

 Group Application of Mesh Settings

It is possible to edit the mesh settings of multiple object simultaneously. The technique is
similar as to other parts of the EMPro GUI: paste the settings on objects. For mesh
settings there is a button available on the Meshing Properties Editor called “Copy to
Clipboard” (see Illustration 8). After the copy operation is done, it is possible to select a
group of parts and then request the context menu and perform the “Paste” action (or
using the shortcut).

 Performance

Below is an excerpt of the results obtained by using the new mesh controls. The results
are indicative and are not generally applicable.

The time for the Microstrip 50 Ohm is normally dominated by the refinement process.
Using an edge mesh of 0.4 mm, the initial mesh and final mesh are the same. For the
patch, the number of steps is reduced as the initial mesh on the conductors is the final
mesh. The radiation into freespace necessitates the additional steps. The example
Microstrip_dipole has a bad convergence behavior because an internal port is used where
a sheet port or waveguide port should be used. The edge meshing however shortcuts
quite a bit of the refinement process by initially providing a denser mesh where it is the
most useful. The final number tetrahedra remains almost equal indicating that the initial
mesh was not over-meshing.

 Edge/Vertex Meshing Guidelines

Following guidelines can be used while applying the edge and vertex meshing:

For conductive paths, apply an edge mesh with length roughly 1/5th of the width of
the strip.
Use vertex meshing as the additional number of tetrahedra is often quite minimal
and the results are more accurate.
If it is deemed overkill to apply the edge meshing on all conductors, apply at least to
the objects closest to a port. For coaxial structures selecting the objects having a
face in the plane of the waveguide and selecting an edge mesh there is beneficial.

 Adaptive vs Initial Meshing
When the new mesh controls are used, EMPro generates a large increase in the number of
tetrahedra of the initial mesh, although the final mesh typically has the same number of
unknowns. Even in that case it is beneficial to use (for instance) edge meshing. The
resulting mesh is always of higher of quality and this influences the quality of the results
as well.

The following figure displays a converged mesh having edge meshing on conductors
applied.
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 Final Mesh with Edge Meshing on the Initial Mesh.

In the following figure, the adaptive refinement process has chosen the points for mesh:

 Final Mesh after Adaptive Meshing.
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